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ProjectWise Web Server Configuration
ProjectWise Web Server and Web View Server provides users with web access to ProjectWise.
ProjectWise Web Server and Web View Server is really two servers delivered in a single installation. After
installation you choose which server to deploy:
• ProjectWise Web Server is the server to deploy when you want to provide users with normal access to
ProjectWise, where they can check out documents, add new documents and folders, and so on. Bentley
CONNECTION Passport usage is reported in SELECTserver for the users who connect to ProjectWise Web
Server.
• ProjectWise Web View Server is the server to deploy when you want to provide users with read-only access
to ProjectWise. No Bentley CONNECTION Passport usage is reported in SELECTserver for the users who
connect to ProjectWise Web View Server.
You can deploy either server to a SharePoint website or to a standalone IIS website. Once a user connects to the
website, they interact with ProjectWise through a set of ProjectWise Web Parts that you embed into the website.
If using a SharePoint website, you add ProjectWise Web Parts like you would add any other web parts. If using a
standalone website, the installer delivers two example ASP pages (default.aspx or defaultspatial.aspx)
with ProjectWise Web Parts preconfigured. For standalone websites you can also create your own ASP pages
and add ProjectWise Web Parts to them.

Before You Install and Deploy ProjectWise Web Server and Web View
Server
How you configure the computer prior to installation depends on whether or not you are using SharePoint.
1. Installation of the ProjectWise Web Server delivered in this release assumes that you already have a working
ProjectWise and datasource configured, installed from the latest ProjectWise V8i (SELECTseries 4) Refresh,
build version 08.11.11.590.
2. See the readme (readme_projectwise.chm) delivered with this ProjectWise Web Server release for system
requirements.
3. Be an administrator of the computer you are about to configure.
4. In Server Manager, turn on the Web Server (IIS) role and the following role services:
• Web Server
• Common HTTP Features
• Static Content
• Default Document
• HTTP Errors

ProjectWise Web Server

6

Implementation Guide

ProjectWise Web Server Configuration
Before You Install and Deploy ProjectWise Web Server and Web View Server
• HTTP Redirection
• Application Development
• .NET Extensibility 3.5
• ASP
• ASP.NET 3.5
• ISAPI Extensions
• ISAPI Filters
• Health and Diagnostics
• HTTP Logging
• Security
• Windows Authentication
• Request Filtering
• Management Tools
• IIS Management Console
5. In Server Manager, make sure the .NET Framework feature is installed.
6. For SharePoint deployments, install a version of SharePoint supported by this release of ProjectWise,
including the latest updates.
You can use:
• Microsoft SharePoint Server 2013 SP1
• Microsoft SharePoint Foundation 2013 SP1
7. For standalone (non-SharePoint) deployments, if you are working on a computer from which SharePoint has
been uninstalled, make sure that correct IIS permissions are set as described in http://
support.microsoft.com/kb/812614/en-us, as uninstalling SharePoint will affect your IIS permissions.
8. In IIS, it is strongly recommended that you set up SSL for the website where ProjectWise Web Server or
ProjectWise Web View Server will be deployed.

9.
10.

11.
12.

SSL ensures that all communication between the user and the web server (including passwords and other
sensitive data) is encrypted and cannot be read or intercepted by a third party.
For security reasons, it is recommended that the IIS application pool you plan to use does not use the
LocalService or LocalSystem identity.
You can deploy to as many IIS websites as needed on the same computer. ProjectWise Web Server and Web
View Server supports parallel deployments to both SharePoint and standalone (non-SharePoint) websites on
the same computer. ProjectWise Web Server and Web View Server also supports parallel deployments of
both ProjectWise Web Server and ProjectWise Web View Server to different IIS websites on the same
computer. You cannot, however, deploy both ProjectWise Web Server and ProjectWise Web View Server to
the same IIS website.
SharePoint lets you extend a web application to another IIS website; however this is not supported by
ProjectWise Web Server and Web View Server.
For cluster-like functionality in SharePoint, you can set up a web farm. See your SharePoint documentation
for more information.
Note: When installing ProjectWise Web Server and Web View Server in a web farm, you must install it on the
front-end server.

13. If using ProjectWise Publishing Server with ProjectWise Web Server and Web View Server, for performance
reasons it is recommended that you do not install them on the same computer.
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14. If you need to install a ProjectWise language pack, it is recommended that you install the language pack after
installing ProjectWise Web Server and Web View Server, but before deploying ProjectWise Web Server or
ProjectWise Web View Server.
15. You must launch the installer with elevated privileges (Run as Administrator) if:
• You plan to launch the Product Activation Wizard from the final page of the Setup Wizard. This ensures
that the Product Activation Wizard is also run as an administrator, which in turn ensures that the
licensing information you enter through the Product Activation Wizard gets registered to the correct
location in the Windows Registry.
16. For SharePoint deployments, the user you use to deploy ProjectWise Web Server must be an administrator
on the computer you are deploying on, and also an administrator for the local SharePoint installation.

Installing and Deploying ProjectWise Web Server
Installation and deployment is as follows:
1. First you install ProjectWise Web Server and Web View Server.
2. Then you run the Deployment Wizard to select which IIS websites (SharePoint or standalone) to deploy
ProjectWise Web Server or ProjectWise Web View Server to.
You can deploy to any IIS website that ProjectWise Web Server or ProjectWise Web View Server has not already
been deployed to.

To Install ProjectWise Web Server
1. Double-click the setup.exe file to open the ProjectWise Server Setups master installer.
2. Click Install next to ProjectWise Web Server and Web View Server.
3. When the Setup Wizard opens, click Next.
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4. When the License Agreement page opens, read and accept the agreement, then click Next.
The Custom Setup page opens, showing you the features that can be installed, and the location to which the
product will be installed.
The default installation location is C:\Program Files\Bentley\ProjectWise.
5. On the Custom Setup page, accept or change the default installation location and click Next.
6. When the Ready to Install page opens, click Install.
7. When installation is complete, select which Deployment Wizard you want to run next, then click Finish.

The selected deployment wizard opens. At the same time, the Product Activation Wizard opens for you to
configure licensing (on page 54) for this server.

ProjectWise Web Server

9

Implementation Guide

ProjectWise Web Server Configuration
Installing and Deploying ProjectWise Web Server

To Deploy ProjectWise Web Server or ProjectWise Web View Server
1. If the Deployment Wizard you want to run is not already open, open it now by selecting either:
Start > All Programs > Bentley > ProjectWise V8i (SELECTseries 4) > Web Server and Web View Server
> ProjectWise Web Server Deployment Wizard
or
Start > All Programs > Bentley > ProjectWise V8i (SELECTseries 4) > Web Server and Web View Server
> ProjectWise Web View Server Deployment Wizard
2. When the selected Deployment Wizard opens, click Next.

The Deployment Type page opens, displaying the virtual servers (websites) currently available in IIS, and
whether or not ProjectWise Web Server or ProjectWise Web View Server is currently deployed to any of
them.
3. On the Deployment Type, do one of the following:
If you launched the ProjectWise Web Server Deployment Wizard, select Deploy ProjectWise Web Server
and click Next.
or
If you launched the ProjectWise Web View Server Deployment Wizard, select Deploy ProjectWise Web
View Server and click Next.
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4. On the Virtual Server Selection page, select one or more virtual servers (websites) to deploy ProjectWise
Web Server or ProjectWise Web View Server to, then click Next.

5. If the Site Update Required page opens, this means that one or more of the websites you selected to deploy
to does not meet the minimum requirements of ProjectWise Web Server or ProjectWise Web View Server.
Select the websites you want to upgrade, then click Next. (ProjectWise Web Server or ProjectWise Web View
Server will not be deployed to any website listed that you do not select to upgrade.)

6. When the Custom Trust Policy page opens, do one of the following:
Select Automatically configure trust level (recommended) and click Next.
or
Select Do no configure trust policy - I will do it manually and click Next. If you select this option, a text file
opens when you click Finish in the Deployment Wizard. This text file contains the custom trust policy
information for you to manually add to your existing trust policy.
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7. On the Select working directory page, specify a temporary working directory for each website you are
deploying ProjectWise Web Server or ProjectWise Web View Server to.
Please note the following:
• This temporary working directory is used by the ProjectWise Web Server or ProjectWise Web View
Server to store things such as licensing data, images, and files that are being transferred between the main
ProjectWise server and the client making the request.
• Each website must have its own working directory that is not being used by any other ProjectWise Web
Server or ProjectWise Web View Server deployment.
• The working directory must be located on the same computer you are installing and deploying on.
• The working directory cannot be located under the website's home directory (for example, it cannot be
here: C:\inetpub\wwwroot).
• Make sure the local system account has Write permission on the specified working directory.
• To set the working directory for a particular website, click where it says <Click here to set the working
directory>, then in that field type the path to the local folder, or click the folder icon to browse for a local
folder to set as the working directory. Repeat this step for each website you are deploying to.
• UNC paths (\\servername\sharename) are not supported.

8. After you specify a working directory, click Start.
If you specify a working directory folder that does not yet exist, a dialog opens to ask if you would like to
create it now. Click Yes.
9. When deployment is complete, click Finish.
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10. If in step 6 you selected to manually configure the trust policy, a text file opens when you click Finish. This
text file contains the custom trust policy information you need to add to your existing trust policy. For more
information, see your SharePoint documentation.
You can rerun the Deployment Wizard as needed to deploy to another website, or to remove a current
deployment from a website (on page 44).

Configuring Single Sign-On for ProjectWise Web Server
Single sign-on lets ProjectWise users log in to their datasources using the same Windows credentials they used
to log on to their computer. This assumes that their Windows account has already been added to the ProjectWise
datasource they are logging in to.
While the general concept of single sign-on is the same across the different ProjectWise clients, for technical
reasons single sign-on is configured a little differently for ProjectWise Web Server than it is for ProjectWise
Explorer and ProjectWise Administrator users. To enable single sign-on for ProjectWise Explorer and
ProjectWise Administrator users, the administrator simply adds the line SSO=1 to the ProjectWise Integration
Server's dmskrnl.cfg file. This line, however, does not apply for ProjectWise Web Server single sign-on.
To configure single sign-on for ProjectWise Web Server, you need to do the following:
1. Add the IP address of this ProjectWise Web Server computer to the [Trusted Servers] section (on page
13) in the ProjectWise Integration Server's dmskrnl.cfg file.
2. Create a delegate user in ProjectWise Administrator (on page 14).
3. Enter the credentials of the delegate user on the ProjectWise Web Server computer (on page 14).

To Add a Computer to the Trusted Servers List
1. Open the ProjectWise Integration Server's dmskrnl.cfg file.
2. Find the [Trusted Servers] section.
3. Under the [Trusted Servers] line, add a new line that includes your computer's IP address.
You can either add a specific IP address, or you can use a subnet mask. You can also add a new line for each
application, if they are installed on different computers.
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For example:
[Trusted Servers]
ProjectWise Web Server=194.215.205.19
Bentley i-model Composition Server for PDF=192.168.100.0

255.255.255.0

The name before the = can be any name you choose.
The number after the = is the IP address.
The number after the IP address (with a space in between) is the optional subnet mask.

To Create a Delegate User in ProjectWise Administrator
1.
2.
3.
4.

Open ProjectWise Administrator and log in to your datasource.
Create a logical user account (right-click the Users node and select New > User).
Turn on that user's user setting, Administrative > Enable as delegate user.
If needed, add the delegate user to the Administrator group (under the Groups node).
Tip: This step is only required if any of the domain users in the datasource who plan to connect to
ProjectWise through ProjectWise Web Server are also members of the Administrator group in ProjectWise.

5. Repeat this procedure as needed to configure a delegate user in other datasources.
Once a delegate user exists in the datasource, you can go to the ProjectWise Web Server computer and specify
which delegate user will be used for each datasource.

To Enter the Credentials of the Delegate User on the ProjectWise Web Server
Computer
1. On the ProjectWise Web Server computer, select Start > All Programs > Bentley > ProjectWise V8i
(SELECTseries 4) > Web Server and Web View Server > ProjectWise Web Server Single SignOn
Settings.
The Single Sign-On Settings dialog opens for you to specify the delegate user to use for each datasource. If
you have already specified a delegate user for a particular datasource, you can use this same procedure to
change the currently specified delegate user (assuming there is another delegate user in the same
datasource).
This dialog requires elevated privileges.
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2. Select your datasource, enter the user name and password of the delegate user you created in this
datasource, and click Save Settings.
Repeat this step to specify the delegate user to use in other datasources.
3. Click Close.
Note: The datasource list displays whatever datasources are configured to display as the result of configuring
the ProjectWise network on this computer. If the datasource you need to connect to is not listed, close this
dialog, configure the ProjectWise network, then open this dialog again. The ProjectWise network is
configured using the ProjectWise Network Configuration Settings dialog. See Connecting Individual
Clients to the Server (on page 48) for details.

Integrating with ProjectWise Publishing Server
To view and/or markup DGN and DWG documents in the ProjectWise Publishing and Markup web part, you
need to integrate ProjectWise Web Server with ProjectWise Publishing Server.

ProjectWise Publishing Server Integration Checklist
1. For better performance it is recommended that you do not install ProjectWise Publishing Server on the same
computer as either ProjectWise Web Server and Web View Server or SharePoint. If you need to install
ProjectWise Publishing Server and ProjectWise Web Server and Web View Server on the same computer for
some reason, you can only use a 64-bit Windows Server 2008 operating system.
2. Install the Web Server (IIS) role and role services (on page 16) required for ProjectWise Publishing Server.
3. Install the following on the same computer:
• Prerequisites for Bentley Desktop Applications (08.11.07.03 or later)
• ProjectWise Publishing Server V8i (SELECTseries 4) (08.11.11.16) (on page 21)
• ProjectWise Publishing Gateway Service V8i (SELECTseries 4) (08.11.11.590) (on page 21)
Note: Prerequisites for Bentley Desktop Applications and ProjectWise Publishing Server are each separate
downloads, available from the Bentley Software Fulfillment Center.
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Note: This Web Server-only release does not deliver ProjectWise Publishing Gateway Service, therefore you
must use the version of ProjectWise Publishing Gateway Service that is delivered with ProjectWise Server
Setups V8i (SELECTseries 4) (08.11.11.590).
4. In ProjectWise Administrator, do the following:
a. Add the ProjectWise Publishing Server address to the datasource settings (on page 23).
b. Set ProjectWise Publishing Server as the web viewer for DWG and DGN documents (on page 24).

To Install the Web Server (IIS) Role and Role Services Required for ProjectWise
Publishing Server
1. In Server Manager, turn on the Web Server (IIS) role and the necessary role services.
For Windows Server 2008, the following role services are required:
• Web Server
• Common HTTP Features
• Static Content
• Default Document
• HTTP Errors
• Application Development
• ASP.NET
• ISAPI Extensions
• ISAPI Filters
• Security
• Basic Authentication
• Management Tools
• IIS Management Console
• IIS 6 Management Compatibility
• IIS 6 Metabase Compatibility
Note: If you encounter a problem installing ProjectWise Publishing Server, check to make sure the IIS 6
Metabase Compatibility role service is turned on, as it is not on by default.

To Install ProjectWise Publishing Server
1. Determine whether you want to run ProjectWise Publishing Server as a Web Server Extension, or as a
standalone HTTP server. Running ProjectWise Publishing Server as a Web Server Extension allows serving
ProjectWise Publishing Server requests through IIS. If you are installing ProjectWise Publishing Server
exclusively for use with ProjectWise Web Server and Web View Server, then Web Server Extension is not
required.
2. If you plan to install ProjectWise Publishing Server on the same computer as ProjectWise Web Server and
Web View Server (which is not recommended), and if you plan to run ProjectWise Publishing Server as a Web
Server Extension, then first create a separate IIS website to install ProjectWise Publishing Server to.
3. Install Prerequisites for Bentley Desktop Applications (08.11.07.03 or later).
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4. Launch the ProjectWise Publishing Server installer.
5. When the Setup Wizard opens, click Next.

6. When the License Agreement page opens, read and accept the agreement, then click Next.
7. When the Destination Folder page opens, accept or change the default installation location, then click Next.
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8. On the Setup Type page, select Custom and click Next.
9. On the Custom Setup page, select which features to install. If Web Server Extension is not needed, do not
install the Web Server Extension Files and Examples Files features. When finished click Next.
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10. On the Web Site Selection page, select the IIS website where ProjectWise Publishing Server files will be
installed and click Next.
Important: If the Web Server Extension feature is selected to be installed from the previous step, do not select
the same website where ProjectWise Web Server or ProjectWise Web View Server is deployed. In this case,
select the dedicated website created in step 2.
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11. When the Ready to Install page opens, click Install.
12. When installation is complete, click Finish.
13. If the Web Server Extension feature was not installed, configure ProjectWise Publishing Server to run in
standalone mode. To do this, open the ProjectWise Publishing Server Administration page (Start > All
Programs > Bentley > ProjectWise Publishing Server > ProjectWise Publishing Server
Administration), navigate to the General Settings page, turn off Run as Web Server Extension, and click
Submit. To apply configuration changes, a server needs to be restarted. Navigate to the Server Control page
and click Restart Server.
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To Install ProjectWise Publishing Gateway Service
1. Make sure ProjectWise Publishing Server is installed on this computer, and that the ProjectWise Publishing
Server service is running.
2. Double-click the setup.exe file to open the ProjectWise Server Setups master installer.
3. Click Install next to ProjectWise Publishing Gateway Service.
4. When the Setup Wizard opens, click Next.
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5. When the License Agreement page opens, read and accept the agreement, then click Next.
6. When the Ready to Install page opens, click Install.
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Note: The installer automatically stops the ProjectWise Publishing Server service during installation, and
restarts it once ProjectWise Publishing Gateway Service is finished installing.
7. When installation is complete, click Finish.

To Add the ProjectWise Publishing Server Address to the Datasource Settings
1. Open ProjectWise Administrator and log in to your datasource.
2. Right-click your datasource and select Properties.
The Datasource Properties dialog opens.
3. On the Settings tab, expand Web Components > Default ProjectWise Publishing Server and double-click
the icon below it.
4. In the Specify server address dialog, enter the name of the computer on which ProjectWise Publishing
Server is installed, followed by a colon, followed by the port number. For example:
http://publishingserver:8087
If ProjectWise Publishing Server is running as a Web Server Extension, specify the port number of the IIS
website where ProjectWise Publishing Server is installed. Otherwise, specify the port number of ProjectWise
Publishing Server as configured in ProjectWise Publishing Server Administration (default is 8087).
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5. Click OK in the Specify server address dialog, then click OK in the Datasource Properties dialog.

To Set ProjectWise Publishing Server as the Web Viewer for DGN and DWG
Documents
1. Open ProjectWise Administrator and log in to your datasource.
2. Under the Applications node, right-click an application you have associated to DGN and/or DWG documents
and select Properties.
3. On the Web viewing tab, set the Associated web viewer to ProjectWise Publishing Server.
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4. Click OK.
Repeat this procedure for all other applications that are associated to DGN and/or DWG documents. If this
step is not done for an application to which a DGN or DWG is associated, then the selected document will not
be able to be viewed or marked up through the ProjectWise Publishing and Markup web part.

Using Workspace Profiles with ProjectWise Publishing Server
If your ProjectWise Web Parts users are viewing DGN documents in folders which have workspace profiles
associated to them, then ProjectWise Publishing Server must have access to:
• the files pointed to by the workspace profile, whether the workspace profile points to a local or network
drive
• the plot drivers in the workspace pointed to by the workspace profile
When a user selects to view a DGN in ProjectWise Web Parts, ProjectWise Publishing Server is really plotting the
DGN, therefore it needs access to the plot drivers, which it normally finds in its own workspace folder. However
if a workspace profile is assigned to the ProjectWise folder, ProjectWise Publishing Server looks where the
workspace profile points, rather than its own workspace directory. MicroStation does not deliver the DPR.PLT
driver (and ProjectWise Publishing Server does) which is what ProjectWise Publishing Server needs to generate
the DPR file. If your users are receiving an error to the effect of “engine failed to generate image/rendition file”,
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check to make sure you have a copy of the “DPR.PLT” in the workspace pointed to by the workspace profile. For
example, copy DPR.PLT from:
C:\Bentley\Program\BentleyPublisher\Engine\Workspace\System\plotdrv
to
P:\Workspace\System\plotdrv

Configuring Design Compare
If you want your users to be able to select two DGN documents (or two renditions produced from MicroStation
sources) in the ProjectWise Content web part, and then see the changed, unchanged, added, and deleted graphics
between those documents in the ProjectWise Publishing and Markup web part, you need to install and set up the
ProjectWise Design Compare utility that is delivered with ProjectWise InterPlot Server.
Note: Renditions produced from non-MicroStation sources cannot be compared. Design Compare is designed to
detect changes in the element itself. In other words, the user must actually modify the element by moving it,
adding vertices, modifying it, changing color, weight, style, or fill. The feature is not designed to detect changes in
the mere appearance of the element that are caused by level symbology setups, plot-time design scripts, view
attribute changes, or shifts in color tables.
When ProjectWise Publishing Server is installed on a 64-bit Windows Server 2008 to a 64-bit application pool
site, the Design Compare utility must be installed to a separate site that uses a 32-bit application pool.

To Set Up Design Compare on the ProjectWise Web Server / SharePoint Computer
1. Install SharePoint. During install, click Advanced (instead of Basic), then select the Web Front End option
(instead of Stand-alone).
2. After SharePoint is installed, go to SharePoint Central Administration.
3. Go to Application Management > Create or extend web application > Create New Web application.
4. Set Use existing IIS Web Site and make sure that Default Web Site is selected.
5. Set Application Pool and Database Name and Authentication sections as usual.
6. Click OK, then restart IIS.
7. Create Site collection on the newly created application.
8. Install and configure the Design Compare utility as described in the following procedure.

To Set Up Design Compare on a Computer Where ProjectWise Web Server and
SharePoint Are Not Installed
1. On a computer where ProjectWise Explorer is installed, install and configure ProjectWise InterPlot Organizer
to create/store IPS and IPARM files in ProjectWise.
Follow directions in the ProjectWise InterPlot Organizer's help under the heading, “Using ProjectWise
InterPlot Organizer with other ProjectWise Applications”.
2. On a computer where ProjectWise Publishing Server is installed, install ProjectWise InterPlot Server.
3. Once ProjectWise InterPlot Server is installed, go to the ...\ProjectWise InterPlot Server\pwdiffwu
directory and double-click the setupDesignCompareUtility.exe file to begin installing the ProjectWise
Design Compare utility.
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4. When prompted to specify a Virtual Directory Alias, enter an alias name.
A typical name might be “PWDI”. This will be the virtual directory that will be used in Internet Information
Server (IIS).
5. When the Virtual Server Selection dialog opens, select your site (PWDI) and finish installation.
6. When setup is complete you must grant the local user account that IIS is using (typically
IUSR_<COMPUTERNAME>) rights to the newly created directory,
C:\Program Files\Bentley\Design Compare Utility\tmp.
To grant these rights, in Windows Explorer, open the Properties dialog for the \tmp folder, click the Security
tab, select the user from the list and turn on Read and Write permissions.
7. Also, make sure you give your Web Parts users Write permission to the Design Compare tmp directory, if the
Design Compare Virtual Directory security does not allow anonymous access, but only allows Windows
authenticated users.
8. In ProjectWise Administrator, right-click your datasource and select Properties. On the Settings tab, expand
Web Components > Design Compare Utility Address, and double-click the icon below it.
9. Do one of the following:
To configure the Design Compare utility to run in secure mode, in the Specify server address dialog turn on
Server uses secure protocol, then enter the name of the computer on which the Design Compare utility is
installed exactly as it appears in your certificate, followed by a forward slash, followed by the name of the
Virtual Directory Alias specified in step 4. For example, https://interplotserver/PWDI. To find the
computer name as it appears in the certificate, open Internet Information Services, go to Web Sites > Default
Web Site > Properties > Directory Security tab > View Certificate > Issued to.
or
To configure the Design Compare utility to run in regular mode, in the Specify server address dialog turn OFF
Server uses secure protocol, then enter the name of the computer on which the Design Compare utility is
installed, followed by a forward slash, followed by the name of the Virtual Directory Alias specified in step
4. For example, http://interplotserver/PWDI.
Note: If the Default Web Site port has been changed from the default port 80, or if you install the Design
Compare utility to a site other than the Default Web Site, then when specifying the Design Compare utility
address, you will also need to specify the port after the server name, and before the Virtual Directory Alias.
For example, https://interplotserver:88/PWDI
Note: The Document > Design Compare menu will be disabled in the ProjectWise Content web part if the
Web Components > Design Compare Utility Address datasource setting is empty, or if it contains an
incorrect Design Compare utility address.

To Set Up a New IIS Site (for Design Compare) That Uses a 32-bit Application Pool,
on a 64-bit Windows Server 2008 Computer
1. In the Control Panel, go to Administrative Tools and launch Internet Information Services (IIS) Manager
using the Run as Administrator option.
2. Under Connections, expand the local computer, right-click Web Sites and select Add Web Site.
3. In the Add Web Site dialog, do the following:
a. In the Web site name field, enter a name for the site, such as: PWDI
b. In the Physical Path field, enter the physical location to where the site lives.
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4.
5.
6.

7.
8.
9.
10.

11.

c. In the Port field, make sure you specify a port that is different than the port ProjectWise Publishing
Server is using.
d. Click OK.
Under Connections, expand the local computer and select Application Pools.
In the Applications Pools list, right-click the PWDI application pool and select Advanced Settings.
In the Advanced Settings dialog, do the following:
a. Set .NET Framework version to No Managed Code.
b. Set Enable 32-Bit Applications to True.
c. Set Managed Pipeline Mode to Classic.
d. Set Identity to NetworkService.
e. Click OK.
Under Connections, select the local computer, then click Features View.
In the Features list, double-click MIME Types.
Under Actions, click Add.
In the Add MIME Type dialog, do the following:
a. In the File Name Extension field, enter: .dpr
b. In the MIME Type field, enter: application/vpr
c. Click OK.
Close IIS Manager.

Authentication Methods for Design Compare
Design Compare supports both Windows and Anonymous authentication methods (Site Properties > Directory
Security > Edit > Anonymous or Windows access) when ProjectWise Publishing Server is running as a web
server extension.
When Windows access is enabled on the website where ProjectWise Publishing Server is installed, you must
also configure WinHTTP proxy settings to include the ProjectWise Publishing Server’s computer name in the
proxy bypass list (for details, see http://support.microsoft.com/kb/291008).
On 64-bit operating systems, make sure you use the 32-bit configuration tools located in the
%systemroot%\SysWOW64 directory.
On 64-bit Windows Server 2008 SP2 and Windows Server 2008 R2, the “proxycfg” utility is not available. Instead
you must use the %systemroot%\SysWOW64\netsh winhttp set proxy command to configure proxy
settings. Also, if User Access Control is enabled, you must run this command with elevated privileges.

Configuring ProjectWise Web Parts in SharePoint
Once ProjectWise Web Server or ProjectWise Web View Server has been deployed to a SharePoint site, you can
add ProjectWise Web Parts to your SharePoint team site. After adding them, you need to connect them to a
ProjectWise datasource. Once connected, then all your users have to do is point a supported web browser to the
SharePoint team site and they will be automatically logged in to the datasource, either using their own Windows
domain account if you have configured ProjectWise Web Parts to use single sign-on, or using the ProjectWise
account you have specified all ProjectWise Web Parts users to use.
Note: For optimal security, it is recommended that you:
• configure SSL in your SharePoint site (see your SharePoint documentation)
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• use single sign-on to connect to ProjectWise datasources (see To Connect Web Parts to a Datasource Using
Single Sign-on, on a SharePoint Website (on page 30))
Note: ProjectWise Web Server requires that the underlying website has Read and Script permissions enabled in
IIS. These permissions are typically configured automatically by your SharePoint installation.

To Add ProjectWise Web Parts to a SharePoint Page
1. Go to the SharePoint page where you want to add a ProjectWise web part and click Edit.
2. On the Insert tab, click Web Part.
3. In the Categories list, click ProjectWise, then in the Parts list, select one or more ProjectWise web parts and
click Add.
Important: If the web parts you just added do not display on the page, try modifying some other aspect of the
page and then saving the page.
The following ProjectWise web parts are available:
•
•
•
•
•
•
•

ProjectWise Content
ProjectWise Navigation Tree
ProjectWise Navigator
ProjectWise Properties
ProjectWise Publishing and Markup
ProjectWise Search
ProjectWise Spatial Content

Note: If you only need to use the ProjectWise Navigation Tree web part, you can add it to the page and use it
independently without adding any other ProjectWise Web Parts to the page.
Note: If you only need to use the ProjectWise Content web part, you can add it to the page and use it
independently without adding any other ProjectWise Web Parts to the page. Before adding the ProjectWise
Content web part and connecting to your datasource, make sure the user setting, Document list - Show
subfolders is on. This lets you see projects and folders in the ProjectWise Content web part, without
requiring the ProjectWise Navigation Tree web part on the page. User settings can be modified from either
ProjectWise Explorer or ProjectWise Administrator.
Note: If you only need to use the ProjectWise Search web part, you can add it to the page and use it
independently without adding any other ProjectWise Web Parts to the page. Whenever you run a search and
the ProjectWise Content web part is not present, a new window opens to display the results of the search, if
there are any.
When you first add your ProjectWise Web Parts, none of them are connected to any datasource. That is covered
in the following procedures. When using SharePoint, it is recommended that you configure the ProjectWise Web
Parts to use single sign-on.
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To Connect Web Parts to a Datasource Using Single Sign-on, on a SharePoint
Website
1. Configure ProjectWise Web Server to use ProjectWise single sign-on (on page 13).
2. On the ProjectWise Web Server computer, log in to the SharePoint site with a Windows domain account that
has administrative rights to that site. Make sure this domain account also exists in the ProjectWise
datasource you plan to connect to.
3. Make sure that your ProjectWise users having Windows domain-based accounts are also added to the
SharePoint site.
If you need to set this up, in SharePoint go to Site Actions > Site Settings > Users and Permissions >
People and groups, click New > Add Users, then add your Windows domain groups and/or Windows
domain users. For most users, you should set their permissions to Team Site Visitors [Read].
Note: This [Read] permission does not mean that the documents and folders found in ProjectWise Web Parts
are read-only, it simply means that users can access the SharePoint site, but they cannot change anything on
the site. For example, they will not be able to add a web part or close a web part. If you want some of your
users to have this ability, then for those users you can set their permissions to Team Site Members
[Contribute]. Team Site Members can also, for example, log in to the datasource as a different user.
4. Add ProjectWise Web Parts (on page 29) to the page.

5. In any ProjectWise web part (ProjectWise Navigation Tree web part is used for this example), select Edit >
Modify Shared Web Part.
A settings window for that web part opens on the right side of the screen.
6. Under Select web parts to connect, turn on all the ProjectWise Web Parts listed.
7. From the Location list, select the ProjectWise datasource you want to connect to.
Tip: The Location list displays whatever datasources are configured to display as the result of configuring the
ProjectWise network on this computer, and will contain the same datasources you saw on the Single Sign-On
Settings dialog in step 1.
8. Turn on Use Windows credentials (SSO) and click OK.
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You, the administrator, are now logged in to the datasource with the same Windows domain account you
used to log in to SharePoint (which also exists in the datasource).
9. When prompted, install the ProjectWise Web Server Client Components.
This installs the following ActiveX controls:
• ProjectWise Web File Transfer ActiveX Control - used by any operation that downloads a file to your local
web parts working directory
• Bentley DGN Navigator Control - used by the ProjectWise Navigator web part
• VPR ActiveX Control - used by the ProjectWise Publishing and Markup web part
• Spatial ActiveX Control - used by the ProjectWise Spatial Content web part
10. In SharePoint, click Exit Edit Mode.
11. Make sure your users' Internet Explorer Internet Options are configured properly.
a. Have your users open Internet Explorer and open the Internet Options dialog (Tools > Internet Options).
b. On the Security tab, and click Custom Level. In the Security Settings dialog, scroll down to the User
Authentication section and turn on Automatic logon with current username and password. Click OK
to close the Security Settings dialog.
c. On the Advanced tab, scroll down to the Security section and turn on Enabled Integrated Windows
Authentication (requires restart).
d. Click OK.
12. Have your users' point their browsers to the SharePoint site.
They will be automatically logged in to the datasource with their Windows domain account, assuming they
are logged in to their operating system with their Windows domain account, and assuming that the domain
account exists both in the datasource and also in SharePoint.
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Have them install the ProjectWise Web Server Client Components when prompted.

To Connect Web Parts to a Datasource Without Single Sign-On, on a SharePoint
Website
If you are testing ProjectWise Web Parts in SharePoint, a quick way to configure the site is to connect to a
datasource without using single sign-on. You can always go back later and configure single sign-on using the
procedure above. Note that the procedure below should only be used for testing and is not recommended for
production. This is because if other users are using this site, they will all be automatically logged in to the
datasource with the same user account you connected with.
1. Add ProjectWise Web Parts (on page 29) to the page.

2. In any ProjectWise web part (ProjectWise Navigation Tree web part is used for this example), select Edit >
Modify Shared Web Part.
A settings window for that web part opens on the right side of the screen.
3. Under Select web parts to connect, turn on all the ProjectWise Web Parts listed.
4. From the Location list, select the datasource you want to connect to.
The Location list displays whatever datasources are configured to display as the result of configuring the
ProjectWise network on this computer. If the datasource you need to connect to is not listed, close this
SharePoint page, configure the ProjectWise network, then open this SharePoint page again. The ProjectWise
network is configured using the ProjectWise Network Configuration Settings dialog. See Connecting
Individual Clients to the Server (on page 48) for details.
5. Enter a ProjectWise user name and password (can be a logical account or a Windows domain account) and
click OK.

ProjectWise Web Server

32

Implementation Guide

ProjectWise Web Server Configuration
Configuring ProjectWise Web Parts in SharePoint

You are now logged in to the datasource with the selected account.
6. When prompted, install the ProjectWise Web Server Client Components.
This installs the following ActiveX controls:
• ProjectWise Web File Transfer ActiveX Control - used by any operation that downloads a file to your local
web parts working directory
• Bentley DGN Navigator Control - used by the ProjectWise Navigator web part
• VPR ActiveX Control - used by the ProjectWise Publishing and Markup web part
• Spatial ActiveX Control - used by the ProjectWise Spatial Content web part
7. In SharePoint, click Exit Edit Mode.

To Modify a Web Part's General SharePoint Settings
1. In the upper-right corner of a ProjectWise web part, click the Edit menu and select Modify Shared Web Part.
On the right side of the screen, a settings window opens.
2. Expand Appearance, Layout, and Advanced, make the necessary changes, and click OK.
These settings are not related to ProjectWise. For more information about them, click the Help link at the top
of the team site page.
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To Set the Topmost ProjectWise Folder or Project That Displays in Various Web
Parts
The Documents root folder is the topmost folder in any datasource. However, you do not have to display the
entire folder structure in ProjectWise Web Parts. You can set any folder or project in the datasource to be the
topmost folder that displays in the ProjectWise Navigation Tree, ProjectWise Content, and ProjectWise Spatial
Content web parts.
1. In the ProjectWise Navigation Tree, ProjectWise Content, ProjectWise Spatial Content, or ProjectWise Search
web part, click the Edit menu and select Modify Shared Web Part.
2. In the settings window, click the Browse button next to the Root path field.

3. In the window that opens, select a folder or project and click OK.
4. Back in the settings window, click OK.
The root folder for the ProjectWise Navigation Tree, ProjectWise Content, and ProjectWise Spatial Content
web parts changes from the Documents root folder to whatever folder or project you set here.

To Set Whether Searches Will Search the Topmost Folder, or the Entire
Datasource
The ProjectWise Search web part has a setting called Limit to Root Path. When this setting is on (the default),
then searches will only search within the folder that is set as the topmost folder to display in the ProjectWise
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Navigation Tree, ProjectWise Content, and ProjectWise Spatial Content web parts. If this setting is on and no top
folder is set, then searches will search the entire datasource. If you turn this setting off and there is a folder set
as the topmost folder, then searches will search the entire datasource instead of just searching the topmost
folder and its subfolders.
1. In the ProjectWise Search web part, click the Edit menu and select Modify Shared Web Part.
2. In the Search settings window, scroll to the bottom and expand Miscellaneous.
3. Do one of the following:
If you want searches to search only the topmost folder and its subfolder, turn on Limit to Root Path.
or
If you want searches to always search entire datasource, turn off Limit to Root Path.
4. Click OK.

To Set the ProjectWise Search Web Part's Default Search Method
1. In the ProjectWise Search web part, click the Edit menu and select Modify Shared Web Part.
2. In the Search settings window, expand Miscellaneous, and set Search Method to General or Advanced.
3. Click OK.
The ProjectWise Search web part is refreshed to show the interface of the selected search mode.

Configuring ProjectWise Web Parts in a Standalone IIS Website
When deploying ProjectWise Web Server or ProjectWise Web View Server in a standalone IIS website — that is,
an IIS website without SharePoint — you can use one of the delivered ASP pages (default.aspx or
defaultspatial.aspx) which has the ProjectWise Web Parts preconfigured, or you can create and configure
your own ASP pages.
This section discusses how to configure IIS for your standalone ProjectWise Web Server or ProjectWise Web
View Server website, and how to connect it to a ProjectWise datasource. Once connected, all your users have to
do is point their supported web browser to this website and they will be automatically logged in to the
datasource, either using their own Windows domain account if you have connected ProjectWise Web Parts using
single sign-on, or using the ProjectWise account you have specified all ProjectWise Web Parts users to use.
Note: Make sure your ProjectWise Integration Server is also of the current version. The datasource's ProjectWise
Integration Server you connect to must be of the same version as the ProjectWise Web Server and Web View
Server.

Configuring IIS Settings in a Standalone IIS Deployment
When you have deployed a ProjectWise Web Server so that users within the organization (internal users) can
have web access to ProjectWise, you should configure the standalone IIS website to use Windows authentication.
ProjectWise Web Server can also be used to provide external consultants access to ProjectWise managed
content. For this to work, you need a website that external users can securely log in to and access only the data
they have been authorized to access. In this case, the recommendation is to deploy ProjectWise Web Server or
ProjectWise Web View Server to a standalone IIS website, enable anonymous access, and finally use ProjectWise
native users to authenticate external users.
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Note: Anonymous authentication is less secure than Windows authentication, so considering taking the
following additional security precautions if configuring a ProjectWise Web Server website with anonymous
authentication:
• Configure the ProjectWise Web Server website to use SSL.
• Restrict ProjectWise user rights to only those that are necessary (for example, disable the user’s ability to
delete documents and folders, if not required).

Enable Your Standalone IIS Website's Read and Script Permissions
1.
2.
3.
4.
5.
6.

Open IIS Manager.
In the Connections pane, navigate to and select the site you deployed to.
Click the Features View tab to go to the site's Home page.
On the Home page, in the IIS section, double-click Handler Mappings.
In the Actions pane, click Edit Feature Permissions.
In the Edit Feature Permissions dialog, enable the Read and Scripts permissions, then click OK.

Configure Your Standalone IIS Website to Use Windows Authentication
1.
2.
3.
4.
5.

Open IIS Manager.
In the Connections pane, navigate to and select the site you deployed to.
Click the Features View tab to go to the site's Home page.
On the Home page, in the IIS section, double-click Authentication.
On the Authentication pane, make sure Anonymous Authentication is set to Disabled, and make sure
Windows Authentication is set to Enabled.

Configure Your Standalone IIS Website to Use Anonymous Access
1.
2.
3.
4.
5.

Open IIS Manager.
In the Connections pane, navigate to and select the site you deployed to.
Click the Features View tab to go to the site's Home page.
On the Home page, in the IIS section, double-click Authentication.
On the Authentication pane, make sure Anonymous Authentication is set to Enabled.

Connecting Web Parts to the Datasource, in a Standalone IIS Deployment
You can configure the Web Parts in your standalone IIS website so that users can log in using single sign-on, or
using one ProjectWise account for all users who connect.

To Connect Web Parts to a Datasource Using Single Sign-on, on a Standalone IIS Website
1. Configure ProjectWise Web Server to use ProjectWise single sign-on (on page 13).
2. On the ProjectWise Web Server computer, make sure you are logged in to the computer with a Windows
domain account. Make sure this domain account also exists in the ProjectWise datasource you plan to
connect to.
3. On the ProjectWise Web Server computer, launch Internet Explorer and enter either:
http://localhost/default.aspx
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or
http://localhost/defaultspatial.aspx
The delivered sample ProjectWise home page opens and displays the login form.

4. From the Location list, select the ProjectWise datasource you want to connect to.
Tip: The Location list displays whatever datasources are configured to display as the result of configuring the
ProjectWise network on this computer, and will contain the same datasources you saw on the Single Sign-On
Settings dialog in step 1.
5. Click Sign in using your Windows credentials.
6. Once the credentials are verified, click Log in.
You, the administrator, are now logged in to the datasource with the same Windows domain account you
used to log in to the computer, which also exists in the datasource.
7. When prompted, install the ProjectWise Web Server Client Components.
This installs the following ActiveX controls:
• ProjectWise Web File Transfer ActiveX Control - used by any operation that downloads a file to your local
web parts working directory
• Bentley DGN Navigator Control - used by the ProjectWise Navigator web part
• VPR ActiveX Control - used by the ProjectWise Publishing and Markup web part
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• Spatial ActiveX Control - used by the ProjectWise Spatial Content web part
8. Make sure your users' Internet Explorer Internet Options are configured properly.
a. Have your users open Internet Explorer and open the Internet Options dialog (Tools > Internet Options).
b. On the Security tab, and click Custom Level. In the Security Settings dialog, scroll down to the User
Authentication section and turn on Automatic logon with current username and password. Click OK
to close the Security Settings dialog.
c. On the Advanced tab, scroll down to the Security section and turn on Enabled Integrated Windows
Authentication (requires restart).
d. Click OK.
9. Have your users' point their browsers to the ProjectWise Web Server by entering one of the following in the
Address field:
http://webserver:portnumber/default.aspx
or
http://webserver:portnumber/defaultspatial.aspx
where webserver is the name of the computer on which ProjectWise Web Server is installed, and
portnumber is the port that the default website is using.
They are now automatically logged in to the datasource, assuming they have a Windows domain account in the
datasource, and assuming they are also logged into their operating system with that same domain account.
Have your users install the ProjectWise Web Server Client Components when prompted.
The next time they visit this site, they will be automatically logged in to the same datasource using single signon.

To Connect Web Parts to a Datasource Without Single Sign-On, on a Standalone IIS Website
1. On the ProjectWise Web Server computer, launch Internet Explorer and enter either:
http://localhost/default.aspx
or
http://localhost/defaultspatial.aspx
The delivered sample ProjectWise home page opens and displays the login form.
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2. From the Location list, select the ProjectWise datasource you want to connect to.
Note: The Location list displays whatever datasources are configured to display as the result of configuring
the ProjectWise network on this computer. If the datasource you need to connect to is not listed, close this
browser, configure the ProjectWise network, then open a browser to this page again. The ProjectWise
network is configured using the ProjectWise Network Configuration Settings dialog. See Connecting
Individual Clients to the Server (on page 48) for details.
3. In the User Name and Password fields, enter the credentials of a ProjectWise user account.
This can be a logical account or a Windows-based account.
4. Click Log in.
You, the administrator, are now logged in to the datasource with the specified account.
5. When prompted, install the ProjectWise Web Server Client Components.
This installs the following ActiveX controls:
• ProjectWise Web File Transfer ActiveX Control - used by any operation that downloads a file to your local
web parts working directory
• Bentley DGN Navigator Control - used by the ProjectWise Navigator web part
• VPR ActiveX Control - used by the ProjectWise Publishing and Markup web part
• Spatial ActiveX Control - used by the ProjectWise Spatial Content web part
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6. Have your users' point their browsers to the ProjectWise Web Server by entering one of the following in the
Address field:
http://webserver:portnumber/default.aspx
or
http://webserver:portnumber/defaultspatial.aspx
where webserver is the name of the computer on which ProjectWise Web Server is installed, and
portnumber is the port that the default website is using.
7. When the sample page opens, have your users do the following:
a. Select the ProjectWise datasource to connect to from the Location list.
b. Enter the correct user name and password and click OK.
c. Install the ProjectWise Web Server Client Components when prompted.
The next time they visit this site, the last used datasource and user name are remembered, and they will only
have to enter their password.

Configuring ProjectWise Web Parts Client Computers
Adding the Web Parts Site to the Trusted Sites List
Adding the Web Parts website address to your browser's Trusted sites list is a requirement for using
ProjectWise Web Parts.
1.
2.
3.
4.
5.
6.

In Internet Explorer, go to Tools > Internet Options.
In the Internet Options dialog, select the Security tab.
Select Trusted sites and click the Sites button.
In the Trusted sites dialog that opens, type your Web Parts website address and click Add.
Click OK to close the Trusted sites dialog.
Click OK to close the Internet Options dialog.

Configure Internet Explorer Security Settings
1. In Internet Explorer, go to Tools > Internet Options > Security tab, select Trusted sites, click Custom Level.
The Security Settings dialog opens for the Trusted Sites Zone.
2. For ActiveX controls to work properly in Internet Explorer, make sure the following options are set:
Category

Setting

Value

ActiveX controls and plug-ins

Download signed ActiveX controls

Prompt

Download unsigned ActiveX controls

Disable

Initialize and script ActiveX controls not
marked as safe for scripting

Disable
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Category

Scripting

Setting

Value

Run ActiveX controls and plug-ins

Enable

Script ActiveX controls marked safe for
scripting

Enable

Active Scripting

Enable

Allow paste operations via script

Enable

Scripting of Java applets

Enable

3. (Windows Server 2008 only) For downloading to work properly when using Internet Explorer on Windows
Server 2008, make sure the following options are set:
Category

Setting

Value

Downloads

Automatic prompting for file downloads

Enable

4. (Internet Explorer 9 only) Additional settings are required when using Internet Explorer 9:
Category

Setting

Value

Scripting

Allow Programmatic clipboard access

Enable

User Authentication

Logon

Automatically logon with
current user name and
password

5. Click OK to save changes and close the Security Settings dialog.
6. (Windows Vista only) For copy outs to function properly when using Internet Explorer on Windows Vista, on
the Security tab of the Internet Options dialog, turn off the setting, Enable Protected Mode.
7. Click OK to save changes and close the Internet Options dialog.

Turning Off Your Browser's Popup Blocker
Occasionally Web Parts needs to open items in a new window. For example, if you right-click a folder and select
Properties when the Properties web part is not present, the properties of the selected folder display in a new
window. When your popup blocker is enabled, these additional windows will not open; therefore you should
disable the popup blocker in your browser. See your browser's documentation for instructions.

Installing .NET Framework 3.5 for the ProjectWise Navigator Web Part
ProjectWise Web Parts users who are using Windows 8 will need to install .NET Framework 3.5 on their
computers, in order to use the ProjectWise Navigator web part.
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Remotely Installing ActiveX Controls for Users
When users visit the Web Parts site for the first time, they are prompted to download the ProjectWise Web
Server Client Components, which installs the following ActiveX controls:
• ProjectWise Web File Transfer ActiveX Control - used by any operation that downloads a file to your local
web parts working directory
• Bentley DGN Navigator Control - used by the ProjectWise Navigator web part
• VPR ActiveX Control - used by the ProjectWise Publishing and Markup web part
• Spatial ActiveX Control - used by the ProjectWise Spatial Content web part
In some cases, you may have to remotely install these ActiveX controls for your users. For example, your users
may not have the administrative permissions on their computer necessary to install the ActiveX controls.
Another possibility is that you have upgraded the minor version of ProjectWise Web Server and Web View
Server (for example, from the initial version of 08.11.11.xxx to a later update of 08.11.11.xxx), while your users
are still using the ActiveX controls that were delivered with the original ProjectWise Web Server and Web View
Server installation, causing the two to become out of sync and requiring that the users' ActiveX controls be
upgraded.
To remotely install the ActiveX controls, you can either use a Group Policy to install them, or you can remotely
connect to your users computers and manually install them. When remotely installing the ActiveX controls, you
need to launch these two installers:
• ProjectWise Web and Web View Servers V8i (SELECTseries 4) Client Components.msi - this
installs the ProjectWise Web File Transfer ActiveX Control, the VPR ActiveX Control, and the Spatial ActiveX
Control
• DgnNavigatorControlAx.msi - this installs the Bentley DGN Navigator Control
Note: These installers are delivered with ProjectWise Server Setups, but are not listed when you launch the
master setup.exe installer. Instead, you will find them in the ...\product\pwwebserver folder.

User Settings for ProjectWise Web Parts Users
The following user settings are specific to ProjectWise Web Parts users. Read the following to determine if you
need to configure these settings for any of your ProjectWise Web Parts users.
Working
Directory - When
Accessing
ProjectWise Over
The Web

Used to preset the user's working directory when using ProjectWise Web Parts.
In a new datasource, the default ProjectWise Web Parts working directory for every user
is set to:
%LocalAppData%\ProjectWise\WebWorkDir\%Datasource%
When this default working directory is set as shown above, the user's working directory
will be created automatically on their computer when they first log in to the datasource
through ProjectWise Web Parts. If it cannot be created in the specified location for any
reason, then the user will be prompted to set their own working directory upon logging in.
The user can always change the location of their working directory by selecting Tools >
Working Directory from the Content web part, however, changing the location of the
working directory from ProjectWise Web Parts does not change the value set for this user
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setting in the datasource. If the user changes their working directory from ProjectWise
Web Parts on one computer, but then uses ProjectWise Web Parts from another computer,
the working directory on the new computer will be created based on the value set for the
user setting in ProjectWise Administrator.
To change a user's default ProjectWise Web Parts working directory, expand this setting,
select the default location displayed, then select it again and wait for it to become editable.
You can enter plain text, a variable, or both. The value you enter should specify the path to
and including the folder name you want the user to use. Note that if you specify a drive
that does not exist on the user's computer, then the user will simply be prompted to select
another location for the working directory.
You can use any or all of the following variables to help create a unique ProjectWise Web
Parts working directory folder name for your users:
• %LocalAppData% — this variable will be expanded to the user's local folder that stores
the data for local applications. For example, on Windows Vista this would expand to
C:\Users\[user.name]\AppData\Local
• %Datasource% — the name of the datasource the user is logging in to
• %User% — the user's ProjectWise user name
If you modify the default ProjectWise Web Parts working directory setting for any user,
then instead of the working directory getting created automatically when they log in to the
datasource through ProjectWise Web Parts, they will be prompted to create the working
directory specified here. If you want to change the default ProjectWise Web Parts working
directory and you also want it to get created automatically (without prompting the user),
then you need to apply a group policy that lets the working directory get created
automatically.
User can only log
in through
ProjectWise Web
View Server

ProjectWise Web View Server is intended for casual ProjectWise Web Parts users who
only need read-only access to ProjectWise. The benefit of using ProjectWise Web View
Server is that ProjectWise Passport usage is not reported in SELECTserver when a user
logs in to ProjectWise, using ProjectWise Web Parts, through a ProjectWise Web View
Server.
If you have deployed a ProjectWise Web View Server, turn this user setting on for those
users who will only be connecting to ProjectWise through ProjectWise Web View Server (if
they try to access ProjectWise through ProjectWise Web Server or ProjectWise Explorer
they will not be permitted to log in). When this setting is off, there is no restriction to
which client the user can log in through.

Support for Microsoft Forefront TMG
ProjectWise Web Server and Web View Server supports Microsoft Forefront Threat Management Gateway
(Forefront TMG) 2010 with the latest updates.

Support for Microsoft Network Load Balancing
ProjectWise Web Server and Web View Server supports Microsoft Network Load Balancing. Make sure the
following is configured:
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• When configuring your port rules, set the Affinity parameter to Single.
• In the ECOM.CONFIG file (located in the site's directory), the key="PublicAddress" setting must be set to
the external server name, when the internal server name differs from the external name. For example:
<add key="PublicAddress" value="https://server1.bentley.com:442"
/>

Undeploying and Uninstalling ProjectWise Web Server and Web View
Server
If necessary you can undeploy a particular instance of ProjectWise Web Server or ProjectWise Web View Server
from a website, and leave the other deployments deployed.
If you need to completely uninstall ProjectWise Web Server and Web View Server from your computer, you must
first undeploy all instances of ProjectWise Web Server and ProjectWise Web View Server that are currently
deployed.
Tip: If you have a ProjectWise Language Pack installed and you are uninstalling ProjectWise Web Server and
Web View Server, make sure you uninstall the ProjectWise Language Pack after uninstalling ProjectWise Web
Server and Web View Server.

To Undeploy ProjectWise Web Server and/or Web View Server
1. From the Windows Start menu, launch the Deployment Wizard for the type of server you have deployed:
Start > All Programs > Bentley > ProjectWise V8i (SELECTseries 4) > Web Server and Web View Server
> ProjectWise Web Server Deployment Wizard
or
Start > All Programs > Bentley > ProjectWise V8i (SELECTseries 4) > Web Server and Web View Server
> ProjectWise Web View Server Deployment Wizard
2. When the selected Deployment Wizard opens, click Next.

The Deployment Type page opens, displaying the virtual servers (websites) currently available in IIS, and
whether or not ProjectWise Web Server or ProjectWise Web View Server is currently deployed to any of
them.
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3. Select the Remove option and click Next.
4. On the Virtual Server Selection page, select the websites from which to undeploy the selected server type
(ProjectWise Web Server or ProjectWise Web View Server click Next.
5. When prompted, click Yes to confirm removal.
6. When removal is complete, click Finish.
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The text that displays in the various windows, menus, dialogs, and error messages can be switched to another
language by installing a ProjectWise language pack.
ProjectWise language packs provide localized interfaces for users of:
•
•
•
•

ProjectWise Explorer
ProjectWise Administrator
ProjectWise Web Parts
Orchestration Framework Administrator

Search the Bentley Software Fulfillment Center to see if there is a ProjectWise language pack for your language.

Before You Install the Language Pack
1. Make sure the application for which you are installing the language pack is already installed.

2.
3.

4.

5.

If you install the language pack first and then the application, the language pack will not apply and you will
have to uninstall and reinstall it to make it apply.
For ProjectWise Explorer and/or ProjectWise Administrator, make sure you first install ProjectWise Explorer
with the User Tools option turned on, as this will be used to set the new locale for these applications.
For ProjectWise Web Parts, the ProjectWise language pack is not installed on user's computers, but on the
ProjectWise Web Server and Web View Server computer. It must be installed to each website in IIS that
ProjectWise Web Server or ProjectWise Web View Server is deployed to, that you want to change the
language for. You must install ProjectWise Web Server and Web View Server before you install the
ProjectWise language pack, but you can install the ProjectWise language pack either before or after you
deploy ProjectWise Web Server or ProjectWise Web View Server.
If your are going to deploy ProjectWise Web Server or ProjectWise Web View Server to a SharePoint site,
make sure the appropriate Microsoft SharePoint Language Packs are obtained from Microsoft and installed.
SharePoint Site Language selection determines use of localized user interfaces.
If you are going to deploy ProjectWise Web Server or ProjectWise Web View Server to a non-SharePoint site,
then make sure your website is configured properly (for details, see http://msdn.microsoft.com/en-us/
library/bz9tc508.aspx

To Install the Language Pack
1. Download your language pack and extract the package.
The extracted folder will look something like this:
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C:\BentleyDownloads
\pw08110901xx
\product
Where XX at the end of the folder name is the two letter abbreviation that indicates the language - like
bas08111349de for German.
2. In Windows Explorer, open the product folder and double-click the MSI file.
3. When the Setup Wizard opens, click Next and follow the prompts to completion.

After You Install the Language Pack
1. ProjectWise Explorer and ProjectWise Administrator computers:
After language pack installation, select Start > All Programs > Bentley > ProjectWise V8i (SELECTseries
4) > Tools > User Tools. In the ProjectWise Tools dialog, select the Set Locale icon and click the Execute
button. In the dialog that opens, select the newly installed language, click OK, then click Close.
2. ProjectWise Web Server computers:
After language pack installation, deploy ProjectWise Web Server or ProjectWise Web View Server, then
restart both ProjectWise Web Server Host Service and Internet Information Services (IISRESET).
3. Orchestration Framework Administrator computers:
After language pack installation, change the display language of the operating system.
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Configuring the ProjectWise Network
Connecting Individual Clients to the Server
The ProjectWise Network Configuration Settings dialog is primarily used to establish a TCP connection from
the ProjectWise client computer to one or more ProjectWise servers in order to obtain datasource list
information and populate the datasource lists in the ProjectWise applications installed on the client computer.
This dialog is delivered with ProjectWise Explorer, ProjectWise Administrator, and ProjectWise Web Server and
Web View Server.
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You can also use the ProjectWise Network Configuration Settings dialog to:
• Block the client from broadcasting UDP requests.
This shortens the time it takes to retrieve the datasource list by not searching for local datasources, and
instead only retrieving the datasources of the servers you explicitly connect to here.
• Direct the client to a server from which they can get server name resolution information.
Depending on the client's socket version and/or the network configuration, the client may have problems
solving IP addresses by host name. For example, a client may be really slow at solving IP addresses by host
name, or may not be able to solve them at all, or the client may fail to retrieve a file from the storage area, or
file operations may be really slow. To eliminate these problems, you should configure the
[NameResolution] section of a server's DMSKRNL.CFG file, and then point the client to that server.
• Configure auto-login settings for integrated applications (for ProjectWise Explorer only)
The iDesktop Auto-Login tab is used to control whether or not ProjectWise Explorer users will be
automatically logged into a particular integrated application, when that integrated application is opened
from the desktop.
• Enable ProjectWise clients to use IPv6
Caution: For better performance it is strongly recommended to prevent the use of UDP when using ProjectWise
Web Server and Web View Server.
Note: Although ProjectWise permits you to enter a hostname (computer name), an IP address, or a fullyqualified domain name (hostname + domain name) in the Hostname fields on the DNS Services and
Datasource Listing tabs, it is recommended that you use fully-qualified domain names (FQDN) here. Direct use
of IP addresses should only be reserved for cases when using DNS names is not an option.
Note: When using host names, make sure the host names are configured for reverse lookup.
Note: If ProjectWise Web Server and Web View Server is installed on the same computer as your ProjectWise
Integration Server, that server's datasources will always display in the Locations list when connecting
ProjectWise Web Parts, even if you turn on Prevent UDP.

To Open the ProjectWise Network Configuration Settings Dialog
1. Do one of the following:
From the Control Panel, on newer 64-bit operating systems: Set the view of the Control Panel to Category
view, then open the category called Network and Internet and double-click the ProjectWise V8i Network
icon.
or
From the Control Panel, on older 64-bit operating systems: Open the folder called View 32-bit Control Panel
Items, then double-click the ProjectWise V8i Network icon.
or
From a command prompt, enter control.exe /name Bentley.ProjectWiseNetConfiguration
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To Connect to a Server and Get Its List of Datasources (TCP)
1. Open the ProjectWise Network Configuration Settings dialog (on page 49).
2. Select the Datasource Listing tab.
3. Enter values for Name, Hostname, and Port and click Add.
• Name is just a descriptive name for the ProjectWise server. For example, Production Server
• Hostname is the fully-qualified domain name (FQDN) of the computer where the ProjectWise server is
installed. For example, server.domain.com
• Port is the specified ProjectWise server's listener port number, which is 5800 by default. You only need to
enter a port number here if the listener port on the server has been changed to something other than
5800. Otherwise you can leave it blank.
4. Click OK.

On 64-bit operating systems, the information gets added to the computer's registry under the key
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Bentley\ProjectWise\08.11\NetworkConfig
\DsListing\Servers.
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To Point to the Server from Which the Client Can Get Server Name Resolution
Information
1. Open the ProjectWise Network Configuration Settings dialog (on page 49).
2. Select the DNS Services tab.
3. Enter values for Name, Hostname, and Port and click Add.
• Name is just a descriptive name for the ProjectWise server. For example, Production Server
• Hostname is the fully-qualified domain name (FQDN) of the computer where the ProjectWise server is
installed. For example, server.domain.com
• Port is the specified ProjectWise server's listener port number, which is 5800 by default. You only need to
enter a port number here if the listener port on the server has been changed to something other than
5800. Otherwise you can leave it blank.
4. Click OK.

On 64-bit operating systems, the information gets added to the computer's registry under the key
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Bentley\ProjectWise\08.11\NetworkConfig\Dns
\Servers.

ProjectWise Web Server

51

Implementation Guide

Configuring the ProjectWise Network
Setting Up ProjectWise to Use IPv6

To Prevent the Use of UDP
1. Open the ProjectWise Network Configuration Settings dialog (on page 49).
2. Do one of the following:
To prevent the use of UDP entirely, turn on Prevent UDP for DNS and Listing on the General tab.
or
To prevent the use of UDP for just server name resolution information, turn on Prevent UDP on the DNS
Services tab.
or
To prevent the use of UDP for just datasource list information, turn on Prevent UDP on the Datasource
Listing tab.
3. Click OK.

Setting Up ProjectWise to Use IPv6
ProjectWise fully supports Internet Protocol Version 6 (IPv6).
Caution: Before you begin, it is highly recommended that you contact Bentley Professional Services to assist you
in setting up ProjectWise V8i (SELECTseries 4) on IPv6.
To run ProjectWise V8i (SELECTseries 4) on IPv6:
• You must have a fully-configured IPv6 DNS server.
• All ProjectWise V8i (SELECTseries 4) clients and servers must be part of the IPv6 network.
• All ProjectWise V8i (SELECTseries 4) clients and servers must be configured to use IPv6, by enabling the IPv6
settings on the ProjectWise V8i Network Configuration Settings dialog.
• All ProjectWise V8i (SELECTseries 4) servers must be configured to use IPv6, by enabling the IPv6 settings in
the dmskrnl.cfg file.
Note: On Windows XP and Windows Server 2003, IPv6 is not installed by default. On those operating systems
you will need to manually install IPv6 before enabling the IPv6 settings in the ProjectWise Network
Configuration Settings dialog.
Note: For situations in which you need to enter a datasource name using both the IP address and the datasource
name (IP:datasource) — for example, when logging in through ProjectWise Explorer or integrated
applications — when using IPv6 you need to enter the IP address inside square brackets [ ]. For example:
[2001:ffff:ffff::1]:datasource
The same is true, when using IPv6, for situations in which you need to enter a server address using the IP
address followed by a port number (IP:port). For example:
[2001:ffff:ffff::1]:port
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To Enable ProjectWise Clients to Use IPv6
Do these steps on each of the ProjectWise Explorer, ProjectWise Administrator, and ProjectWise Web Server
computers in your IPv6 network.
1. Open the ProjectWise Network Configuration Settings dialog (on page 49).
2. On the General tab, turn on IPv6 Enabled and IPv6 Preferred.
3. Click OK.
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ProjectWise licensing is managed by SELECTserver, which tracks the usage of Right to Run licenses reported by:
•
•
•
•
•
•

ProjectWise Integration Server
ProjectWise Caching Server
ProjectWise Web Server and Web View Server
Bentley i-model Composition Server for PDF
Bentley i-model Composition Server for i-model (extension to ProjectWise Automation Service)
ProjectWise PDx Project Server

SELECTserver also tracks the usage of Bentley CONNECTION Passport licenses used by ProjectWise Explorer,
ProjectWise Administrator, Bentley Navigator, and ProjectWise Web Parts users who are logging in through
ProjectWise Web Server.
Note: SELECTserver does not track ProjectWise Web Parts users who log in through ProjectWise Web View
Server.
Note: On each computer that you have Bentley software installed, that computer can only report to one
SELECTserver. Therefore if you have multiple products on the same computer that require licensing through
SELECTserver, you only need to run the Product Activation Wizard once on that computer for all the products
that require licensing.

Activating Your Product
Product activation is achieved by connecting to a SELECTserver, receiving verification that your SELECTserver
Name and Activation Key are correct, and successfully posting usage logs. Product activation is not the same as
checking out a license. This section describes how to configure ProjectWise Integration Server for activation.
After initial configuration, ProjectWise Integration Server automatically and transparently tries to activate each
time it runs, and runs unconstrained for a period of 30 days after its last successful activation. However, if
activation is unsuccessful for a period of 30 days, ProjectWise Integration Server reports license expired
exceptions until the license is successfully activated again.

Using the Product Activation Wizard
The Product Activation Wizard is designed to step users through the product activation process. After a product
is installed, you must obtain a license and then activate that license. Obtaining the license alone is not enough to
complete the process. This wizard eliminates the confusion and makes it clear that obtaining a license and
activating a product are two essential steps.
The first screen of the Product Activation Wizard offers these product activation options:
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•
•
•
•

SELECT subscriber activating against a hosted (Bentley) SELECTserver
SELECT subscriber with a deployed (local) SELECTserver
NON-SELECT or Node Locked user
Evaluation Only - No license information

The wizard steps you through the activation process based on the options selected.

SELECT Subscriber Activating Against a Hosted (Bentley) SELECTserver
If you are activating against a hosted (Bentley) SELECTserver, the Server Name is pre-populated but you must
provide the proper Activation Key provided by the Bentley Sales Support Center).
1. Select SELECT subscriber activating against a hosted (Bentley) SELECTserver and click Next.
The Activating against a SELECTserver page opens.
2. Enter the site activation key in the Site Activation Key field.
3. If you are using HTTPS, turn on HTTPS (SSL).
4. If you are using a proxy server to connect to the SELECTserver, click the Proxy button and fill in the Proxy
Server information, then click OK.
5. Click Test Connection to verify the connection to the SELECTserver.
6. Click Next.
The Country of Use page opens.
7. Select the country where you will be using this product and click Next.
The Wizard Selections page displays the information provided on the previous pages.
8. Review the information and click Finish to activate the product.

SELECT Subscriber with a Deployed (local) SELECTserver
If you are activating against a local SELECTserver, you must provide the proper Server Name and Activation Key.
The Server Name and Activation Key, along with any proxy configuration information, can be obtained from your
Site Administrator.
1. Select SELECT subscribers with a deployed (local) SELECTserver and click Next.
The Activating against a SELECTserver page opens.
Enter the name of the server in the Server Name field.
Enter the site activation key in the Site Activation Key field.
If you are using HTTPS, turn on HTTPS (SSL).
If you are using a proxy server to connect to the SELECTserver, click the Proxy button and fill in the Proxy
Server information, then click OK.
6. Click Test Connection to verify the connection to the SELECTserver.
7. Click Next.

2.
3.
4.
5.

The Country of Use page opens.
8. Select the country where you will be using this product and click Next.
The Wizard Selections page displays the information provided on the previous pages.
9. Review the information and click Finish to activate the product.
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NON-SELECT or Node Locked User
If you are not a Bentley SELECT subscriber and you are activating your product, you are presented with three
options:

I have a license file ready to import
1. Enter the path to your license file (or Browse to the location of your license file) in the License File field.
2. Click Next.
The Wizard Selections page displays the information provided on the previous pages.
3. Review the information and click Finish to activate the product.

I have an activation key
1. Enter the site activation key in the Site Activation Key field.
2. If you are using HTTPS, turn on HTTPS (SSL).
3. If you are using a proxy server to connect to the SELECTserver, click the Proxy button and fill in the Proxy
Server information, then click OK.
4. Click Test Connection to verify the connection to the SELECTserver.
5. Click Next.
6.
7.
8.
9.

The Check out license now? page displays.
Enter your email address in the Email Address field.
Select the product to be activated (if not pre-populated) in the Product Name field.
Enter the product version number (if not pre-populated) in the Product Version field.
Click Next.

The Country of Use page opens.
10. Select the country where you will be using this product and click Next.
The Wizard Selections page displays the information provided on the previous pages.
11. Review the information and click Finish to activate the product.

I do not have any license information
1. The product will run in evaluation mode.
2. Click Go To Bentley.com to request activation information.

Evaluation Only - No License Information
1. The product will run in evaluation mode.
2. Click Go To Bentley.com to request activation information.

Client-side Licensing for ProjectWise Web Parts Users
By default, Bentley CONNECTION Passport license usage by ProjectWise Web Parts users connecting to
ProjectWise Web Server is automatically reported to the SELECTserver that your ProjectWise Integration Server
is connected to, and there is nothing else you need to configure to track the license usage of those users.
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However, if you need some ProjectWise Web Parts users to use a different SELECTserver, then you must do the
following:
1. On the ProjectWise Web Server computer, launch the Product Activation Wizard (on page 57) and enter the
name of another SELECTserver and that server's Site Activation Key.
2. Next, open ProjectWise Administrator, log in to your datasource and go to the Users datasource node. For
each ProjectWise Web Parts user who needs to use a different SELECTserver, right-click the user account and
select Properties. On the Settings tab, expand the Administrative category and set Client Licensing to
Activate and record usage through client's configured SELECT Server.

Launching the Product Activation Wizard from the Desktop
If you skipped the Product Activation Wizard step at the end of your installation, or if you need to change your
existing SELECTserver information, you can run the Product Activation Wizard later by launching the
ActivationWizard.exe file, or by first launching the License Management Tool (LicenseTool.exe) and then
selecting Tools > Product Activation Wizard.
The ActivationWizard.exe and LicenseTool.exe files are located under:
...\Bentley\ProjectWise\bin

for ProjectWise Integration Server, ProjectWise
Caching Server, and ProjectWise Automation Service

...\Bentley\ProjectWise\Web\Bin

for ProjectWise Web Server and Web View Server

Important: If you are launching the Product Activation Wizard in one of the ways described above for your
ProjectWise Web Server and Web View Server installation, then after running the Product Activation Wizard,
you must restart IIS.

Launching the Product Activation Wizard with Elevated Privileges
Because of certain access control restrictions to the Windows Registry in Windows Server 2008 and later, on
those operating systems the Product Activation Wizard must be launched with elevated privileges. This can be
done by logging in to the computer with an administrator account and then launching ActivationWizard.exe
or LicenseTool.exe, or by right-clicking ActivationWizard.exe or LicenseTool.exe and selecting Run as
Administrator.
If the Product Activation Wizard is not launched with elevated privileges, the Product Activation Wizard will add
the licensing information to the HKEY_CURRENT_USER section of the Registry instead of HKEY_LOCAL_MACHINE.
When the server looks for and cannot find the licensing information under HKEY_LOCAL_MACHINE, the server
enters 30-day countdown mode. After the 30-day countdown mode expires, the server enters 4-hour evaluation
mode. You cannot fix the problem simply by rerunning the Product Activation Wizard, because the Product
Activation Wizard will find a valid licensing configuration under HKEY_CURRENT_USER and therefore will not
move the licensing information to the location it needs to be in.
To correct the issue if it occurs:
1. Launch the Windows Registry Editor (regedit.exe) application with elevated privileges. This can be done
by logging in to the computer with the Administrator account and launching regedit.exe, or by rightclicking regedit.exe and selecting Run as Administrator.
2. In the Registry Editor, navigate to the HKEY_CURRENT_USER\Software\Bentley registry node, then delete
the Licensing registry key and all its subkeys.
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3. Close the Registry Editor.
4. Launch the Product Activation Wizard with elevated privileges as described above, then reenter your
SELECTserver activation information.
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